
From the Editor:
The holiday shopping season is here, and you may be looking for Apple products for others or for 
yourself. If so, you may find some of the Hot Links of the Month helpful. I’ve included links to 
product reviews and buying guides for iMacs, iPods, the 13” Macbook, and the Mac Mini. The new 
iMac lineup is receiving high marks for their power, speed, and displays, and if a new iMac is on 
your list, you’ll want to read the links to the many reviews – one review even asks, “Why buy an 
expensive Mac Pro when the new iMac is faster?” Also, if you’re considering or already own an 
Apple TV, you’ll want to read the article about version 3.0.

I’ve also included some interesting articles about how often to verify your backups, and why and 
how you could set up your workspace with multiple monitors.

Ron Heck, Publications Director
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Meeting Locations and Leaders
 Meeting  Location  Leader
 Board of Directors  Merriam Park Library, 1831 Marshall Ave, St Paul  Bruce Thompson, 763-546-1088
 iWork/AppleWorks
 SIG

 Southdale Library, 7001 York Ave. S., Edina, MN  John Hunkins Sr, 651-457-8949

 Mac OS X SIG  The Foundation, 311 7th Ave N, Minneapolis  Bob Demeules, 763-559-1124
 Mac Q&A SIG  Merriam Park Library, 1831 Marshall Ave, St Paul  Les Anderson, 651-735-3953
 Macintosh
 Consultants SIG

 Good Day Café, 5410 Wayzata Blvd, Golden Valley  Bob Demeules, 763-559-1124

 TC Photoshop User
 Group*

 Minneapolis College of Art & Design, Auditorium
 150, 2501 Stevens Ave S, Minneapolis

 Jeff Tranberry, phone number not
 available

 VectorWorks SIG*  CJR Office, 4441 Claremore Dr, Edina  Charles Radloff, 952-941-1667
* This SIG is NOT sponsored by mini’app’les; the listing is provided as a service to members.This SIG is NOT sponsored by mini’app’les; the listing is provided as a service to members.This SIG is NOT sponsored by mini’app’les; the listing is provided as a service to members.
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Tuesday Dec. 1 7:00 pm Mac OS X SIG

Wednesday Dec. 2 6:30 pm iWork/AppleWorks SIG
Monday Dec. 7 7:00 pm Board of Directors Meeting

Wednesday Dec. 9 7:00 pm VectorWorks SIG*
Wednesday Dec. 9 7:00 pm TC Photoshop User Group*

Thursday Dec. 17 7:00 am Macintosh Consultants SIG
Monday Dec. 28 7:00 pm Mac Q&A SIG
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iWork/AppleWorks SIG of November 2009
by Harry Lienke

The projector has been well-
behaved since the last 
iWork/AppleWorks SIG 
meeting where Bruce 
Thompson applied a hex 
causing the projector to 
misbehave. Since we viewed more training 
videos, it was good to have a working projector.

Our friendly facilitator, Pam 
Lienke, started off by showing a 
tutorial video called Inspector. It 
pointed out that although many 
formatting options are shown on 
the Format Bar, the advanced 
capabilities of iWork are available through the 
Inspector. The video browsed the various Pages 
options available after the Inspector button on 
the Toolbar is clicked. Pam indicated she would 
like to use the hyperlink capability of the 
Inspector to link from one place in a document 
to another, like from a Table of Contents to the 
referenced text in the document, but had not 
been able to figure out how to do it. Maybe at 
our next meeting she will show us how to use 
bookmarks to hyperlink within a document.

The second tutorial video, Sections, reminded us 
how the Template Chooser can be used to 
preview the pages of a template by moving the 
cursor across the template icon. Double-clicking 

on a word processing template selects it for 
defining our new document and displays the 
first section or two of the template. Sections are 
added to the document using the Sections 
button on the Toolbar to select the type of 
section to be added. Thumbnail images of the 
pages are revealed in a sidebar at the left of the 
window when the View button of the Toolbar is 
clicked and the Page Thumbnails option is 
selected. If no section is selected in the 
thumbnail display, section breaks are indicated 
by light horizontal lines; if a section is selected, 
a yellow box surrounds all pages included in 
that section. The thumbnails can be used to 
rearrange the sections, if you desire. A section 
can be divided into two sections at the cursor 
location by selecting Insert > Section Break from 
the menu. Pam showed how a Layout Break can 
be used to affect only the column layout of the 
document while a Section Break can be used to 
affect headers, footers, page numbering, 
margins, and background image as well as 
column layout. If you use the View button on 
the Toolbar to Show Invisibles, you can 
differentiate between a Layout Break (the icon 
looks like an upper-case T within a rectangle) 
and a Section Break (a rectangle with a thick left 
side and containing an equal sign [=]). Pam 
pointed out the Previous Page and Next Page 
buttons that look like arrows at the bottom 
center of the window; with the Action menu 
button located just to the right of the arrows 
you can choose to navigate to various other 
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document items, such as section, comment, 
hyperlink, or paragraph style.

Pam showed a third video called 
Magic Move; it demonstrated how 
Keynote can animate the 
movement of an object between 
two slides that are back-to-back. An 
image, for example, can appear to 
float from one slide to the next even though its 
size and position are different on the two slides.

Les Anderson sent Pam a link 
(http://www.macworld.com/
article/142395/article.html) to a 
tip on a way to simulate Microsoft 
Office’s Paste Special command. If 
you have a table you would like to 
include in a Pages document but do not want 
readers of the document to be able to edit the 
table, copy the table in Numbers and paste it 
into a Preview document as a PDF (File > New 
from Clipboard), copy the table in Preview and 
paste it into Pages, and then admire your 
cleverness. The table is now a graphic that 
cannot be edited.

John Hunkins mentioned an article he had seen 
describing how to keep track of changes in 
Pages (http://www.macworld.com/article/
143554/pageschanges.html). With a document 
open, use the menu to select Edit > Track 
Changes. A new Tracking Toolbar is inserted 
just above the document window to help you 
with adding text and comments, deleting text, 
and making changes, all the while keeping track 
of each modification you have made. After you 
save the document, you can send it to other 
Pages and/or Word users so they can review 
your alterations.

The iWork/AppleWorks SIG will meet next at 
the Southdale Library, 7001 York Ave. S, in Edina. 
The meeting will commence on December 2, 
2009, at 6:30 pm and will conclude by 8:45 pm. 
Next month Pam plans to show a video called 
Insert and Format Text, investigate the use of 
bookmarks as hyperlinks in Pages, and pose 
some questions she has about using Numbers.

OS X Meeting of Nov. 3, 2009
by Bruce Thompson

Bob Demeules started the 
meeting by demonstrating the 
new wireless Magic Mouse from 
Apple. This mouse is the first 
“multi-touch” mouse available. Besides the 
standard mouse activities (scroll, click, right-
click), it also senses gestures similar to the 
trackpads on Mac laptops and the iPhone. It 
even supports the “momentum scrolling” so 
popular on the iPhone. The software for the 
Magic Mouse is not included in OS X 10.6.1, but 
will be in 10.6.2. (Note: 10.6.2 was released 
November 10). The new mouse also has laser 
tracking, which should provide better control 
on all surfaces. The mouse is battery-operated 
and has an expected battery life of four months.

Bob then demonstrated the latest release of 
Safari, as well as some of the more popular 
plug-ins. In particular, a plug-in called Glims 
provides for quite a bit of extra configurability 
for Safari. It provides additional features for the 
tabs; it allows more configuration of the search 
engines; it allows more control of the “auto-
complete” function; it allows you to change the 
way windows are controlled; and several other 
features. And it is free! Bob also mentioned 
another plug-in, SafariBlock, as a way to 
prevent being overwhelmed by advertisements.

Discussion then moved on to some of the new 
hardware recently released by Apple. The new 
iMacs use a different Intel chip from previous 
models. The new chips, called the Core i5 and 
Core i7, are in the new 21.5” and 27” models. 
One model is even available with a “quad-core” 
processor, which, along with the high-end 
graphics card, would provide even the 
professional graphic artist plenty of power.

Apple also has introduced a new version of the 
Mini as a server. It comes with Snow Leopard 
Server edition and two, 500 GB drives. The 
consensus was that it would provide a terrific 
media server for home use or a file server for a 
small office. 
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Finally, Apple has redesigned the MacBook 
with a plastic unibody enclosure and a built-in 
battery. It has also updated the display and 
trackpad to be consistent with the other laptops.

Bob then moved on to a demonstration of 
Bento 3, a lightweight database from FileMaker . 
It automatically ties in to several databases on 
your Mac – Address Book, iPhoto, Mail, and iCal 
in particular. You can also create other databases 
as needed. While it is not a relational database 
such as FileMaker, it is similar to the old 
Appleworks database and will provide what 
many users are looking for – the ability to store, 
sort, and query information. It comes with many 
predefined libraries (their name for a database) 
and the layout can be changed by selecting from 
several predefined themes.

Bento works interactively with the Address 
Book and iPhoto. You can make an edit in 
Bento, and the changes will appear in the other 
applications or you can make edits in the 
applications, and the edits will show in Bento. 
There are some limitations as to what can be 
edited, especially in iPhoto, but you can see the 
photos from iPhoto while changing or adding to 
the information in iPhoto. Bento databases can 
be shared with up to five users on the local 
network. The shared files can be edited if the 
original author allows.

Q&A SIG of October 2009
By Les Anderson

A number of varied topics were
discussed at the meeting. Several
people had questions or problems with web 
browsers. One person suggested an alternative 
browser, Camino, which uses the Mozilla 
format. It is available at http://
caminobrowser.org/releases/2.0/. Some web 
pages are more friendly to Internet Explorer 
and don’t display properly in Safari. Safari’s 
Debug menu will emulate Explorer if you 
modify Safari.

There was a question about how to know just 
what memory, software, etc., is installed on the 
computer. Under the Apple menu, select About 
This Mac, and you can then click the More Info 
button to get detailed information from System 
Profiler.

Finally it was mentioned that there is a 
Shareware Utility called X-Ray that gives more 
information about files and folders than the Get 
Info option available from the Finder.

Everyone is welcome at the Q&A SIG. We meet on 
the fourth Monday at the Merriam Park Library.

International Verify Your Backups Day
by Adam C. Engst 

I’m not a superstitious sort, though I admit to 
preferring a particular jersey and shorts when I’m 
racing. But for many people, Friday the 13th is an 
inauspicious day, long reputed to be unlucky. 
[Editor’s Note: Friday the 13th occurred in November]

So I propose that we fight back against both 
superstition and the forces of entropy that 
constantly tear down all those works we labor 
so hard at creating.

The best defense against entropy is a good backup 
strategy. To quote a long-ago ad campaign from 
backup software maker Dantz Development, “To 
go forward, you must back up.”

But as those of us who have had to rely on our 
backups in the past know, the act of backing up 
is only the first small step in the full equation - 
it’s being able to restore that really matters.

Some psychiatrist friends with their own 
practice once ran afoul of this in a serious way. 
Their bookkeeper had religiously been making 
backups of all their invoicing and billing 
records as she worked, but she had never tried 
restoring from those backups until her hard 
disk died. When she went to restore from her 
carefully prepared backups, she was aghast to 
discover that they hadn’t been working. Months 
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of data was lost, and it was a huge problem 
both for the bookkeeper and for my friends.

Therefore, I humbly submit that Friday the 13th, 
whenever it rolls around, should be considered 
International Verify Your Backups Day. (The 
United Nations is welcome to make this official, 
and if someone wants to add it to the Wikipedia 
page linked above, that would undoubtedly 
help spread the word.) In 2009, Friday the 13th 
arrives in February, March, and November. If 
you’re reading this article on some other day, 
I’d encourage you to verify your backups right 
away and then continue with the Friday the 
13th schedule.

Take a few minutes to identify some critical files 
and see if you can restore them successfully 
from your backups. If a bootable backup is part 
of your backup strategy, make sure you can 
actually boot from it. (If you don’t have a good 
backup from which you can restore right now, 
allow me to recommend two of our most 
popular ebooks, Joe Kissell’s “Take Control of 
Mac OS X Backups” or “Take Control of Easy 
Backups in Leopard.”)

That’s it. No costumes are necessary, there’s no 
obligatory greeting, and you aren’t expected to 
make a special meal. If you feel the need to 
honor your successful verification, well, a little 
celebratory imbibing of your favorite beverage 
is never inappropriate.

But do tell your friends, relatives, and colleagues 
about International Verify Your Backups Day. 
Because losing data is not a question of if, but of 
when, and good backups from which you can 
restore reliably will protect you from unexpected 
losses small and large alike.
Unless otherwise noted, this article is copyright © 2009 TidBITS 
Publishing, Inc. TidBITS is copyright © 2009 TidBITS Publishing 
Inc. Reuse governed by Creative Commons License.

Put More Pixels on Your Desktop with 
ViBook+
by Adam C. Engst 

Earlier this year, Jeff Carlson reviewed the 
ViBook, a $129 device that enables you to add 
an additional monitor to any Mac (or PC 
running Windows) via USB (see “My Three 
Screens, via ViBook”, 29 May 2009). Although 
Apple’s desktop Macs now all support at least 
two monitors, and you can add oodles of them 
to a Mac Pro with the appropriate video cards, 
Apple’s laptops are limited to a single 
additional monitor.
“Now,” you might ask, “why would you want 
even two monitors on a Mac?” Productivity, my 
friends, productivity. Spaces is all fine and nice, 
but nothing beats having more screen real estate. 
I’ve been running multiple monitors on my 
Macs since my SE/30 in 1990, and I wouldn’t 
use a single-monitor Mac for my work.
“Fine,” you say, “but why would you want 
three monitors on a MacBook or MacBook Pro? 
Isn’t that just gilding the lily?” Not really, and 
although I can’t give statistics on this, my 
experience over the years is that two monitors 
that match in size and screen resolution (and 
ideally, manufacturer), positioned side-by-side, 
are better than two mismatched monitors.
Normally, on my 13-inch MacBook, I can 
connect one 24-inch display running at 1900 by 
1200, but attempting to line that up with the 
MacBook’s own 1280 by 800 display is awkward 
at best, and ergonomically evil at worst. Call me 
greedy, but if I were to use a MacBook or 
MacBook Pro as my only Mac, I’d want a pair of 
24-inch displays, plus the laptop’s own display.
A year ago, toward the end of 2008, when I 
bought my 13-inch unibody MacBook, I 
desperately wanted to make this work, but I just 
couldn’t, because the ViBook at the time 
couldn’t drive a display larger than 1680 by 
1050. After researching all sorts of hacks, I 
finally gave up and bought a Mac Pro to run a 
pair of Dell 24-inch displays (which aren’t as 
good as Apple’s, but which do standard DVI 
instead of Mini DisplayPort and which cost 
about half as much). At the time, I was starting 
a new edition of my “iPhoto ‘09: Visual 
QuickStart Guide” in InDesign, and I needed all 
the screen space I could get.
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Undeterred by the resolution limitation, though, 
Jeff Carlson gave the ViBook a try, and although 
he found that it worked, he ran up against a 
number of issues, including lack of 3D 
acceleration, an inability to color-calibrate the 
display, and relatively slow performance. These 
limitations meant it couldn’t be used for iPhoto 
slideshows or Keynote presentations, or iMovie 
at all. And although video and games did work, 
their performance was often such that it wasn’t 
worth using the ViBook-driven display for 
those purposes.
So when Harmonic Inversion Technology – 
VillageTronic’s U.S. dealer – contacted us again 
to tell us about the $139 ViBook+, I jumped at 
the chance to test it. That’s because the ViBook+ 
can drive monitors at resolutions up to 1920 by 
1200, making it compatible with my 24-inch 
displays (it works with up to 28-inch monitors), 
and it uses a new DisplayLink chip that 
reportedly improves performance. Otherwise, 
and with the exceptions noted below, it’s nearly 
identical to the unit Jeff reviewed earlier this 
year (so be sure to read his review if you’re 
considering purchasing one).
The ViBook+’s installation CD didn’t ship with 
a Mac driver, instead requiring a download, and 
there’s only a beta driver available for Snow 
Leopard (scroll down to get the latest version), 
but it installed fine, and my MacBook 
immediately recognized the 24-inch monitor 
plugged into the little ViBook box. The Displays 

preference pane had no trouble seeing 
the ViBook-driven display and let me 
arrange it with the directly connected 
24-inch monitor and the MacBook’s 
built-in screen.
Although my beta driver didn’t 
include any new release notes, I 
discovered that some of the 
compatibility issues Jeff had 
encountered had disappeared, though 
others had taken their place. iMovie 
launched, and appeared to work on 
the ViBook-connected monitor, 
though I don’t use it enough to know 
if there might be further gotchas. 
iPhoto slideshows worked fine, 
though, strangely, editing did not.
Performance was totally satisfactory. I 
could tell, by grabbing a window and 

moving it up and down quickly, that the ViBook 
couldn’t keep up with the MacBook’s internal 
graphics controller, but it wasn’t troublesome in 
normal usage. YouTube videos played 
acceptably in their normal window with only 
the occasional stutter, but expanding them to 
full screen failed miserably, with the video 
quickly losing sync with the audio. I don’t play 
games, but I suspect full-screen games would 
suffer as well.
Luckily, these performance issues shouldn’t 
really be a problem in most cases, since you can 
always just move the offending program to a 
built-in or directly connected monitor.
I’ll note that although you can attach up to four 
ViBook+ adapters to a Mac, my experience is 
that unless your vision is extremely good, much 
more than two 24-inch displays side-by-side 
may prove hard to use. My eyes simply can’t 
focus much further to either side.
Put simply, the ViBook+ is the product I wanted 
a year ago, and which I would have bought in 
favor of my Mac Pro. At $139 from Harmonic 
Inversion Technology, it’s an inexpensive way 
to add additional monitors to any Mac, and as 
long as you go into the purchase understanding 
its limitations, you won’t be disappointed.
Unless otherwise noted, this article is copyright © 2009 TidBITS 
Publishing, Inc. TidBITS is copyright © 2009 TidBITS Publishing 
Inc. Reuse governed by Creative Commons License.
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Apple TV 3.0 Adds Focus on 
Your Content
by Jeff Carlson 

Apple has introduced version 3.0 
of its Apple TV software, 
revamping the main menu with a 
new look and – finally – a new 
focus. The redesigned top-level 
navigation now features links to 
your content (My Movies, My TV 
Shows, etc.) at the top of each 
section menu; in the previous 
version, the focus was on Apple’s 
paid offerings.

Categories are arranged in a single line, left to 
right. Highlighting a category displays options 
below, like a drop-down menu. The top third of 
the screen features thumbnails of content: for 
example, when the TV Shows category is active, 
your unwatched episodes appear alongside top 
shows from the iTunes Store; press the top 
button on the Apple remote to highlight one of 
the items, and then press the Play button to 
view it.

A new Internet menu item leads to YouTube 
videos and, new to the Apple TV software, 
Internet radio stations. The stations are 
arranged by genre, as you’d find in iTunes. 
When you press and hold the Play button 
during playback of a station, you can choose to 
mark it as a favorite, which then appears at the 
top of the Radio list.

Other new features include photo syncing of 
iPhoto Faces and Events, Genius Mixes, and 
support for iTunes LP albums and iTunes Extras 
movies. However, if you’ve previously 
purchased items with those expanded features, 
they need to be re-downloaded to work with 
the Apple TV; Apple says they will download 
automatically in iTunes.

Aside from the top-level navigation, and a 
switch to Helvetica as the default font, the rest 
of the Apple TV interface is largely unchanged.

The Apple TV hardware remains the same as 
the original model introduced in 2007, although 
now containing a 160 GB hard disk. A new 
Apple TV costs $229.

The Apple TV 3.0 software update is free for 
current owners, and is available only via the 
Apple TV itself (go to Settings > Update 
Software).

Though the improvements in Apple TV 3.0 are 
welcome, they’re unlikely to cause anyone to 
decide to buy an Apple TV, meaning that the 
Apple TV remains a hobby for Apple, and 
merely another small step as Apple gingerly 
pushes its hardware into the living room (the 
previous small move was making the latest 
models of the iMac capable of operating as 
external monitors for Blu-ray players, game 
machines, and the like).

iTunes 9.0.2 and Remote 1.3.2 -- Apple also 
released iTunes 9.0.2 and Remote 1.3.2, which 
add support for the new Apple TV features. 
iTunes 9.0.2 also offers a new preference to use a 
dark background behind the Grid view, located 
in the General pane of the iTunes preferences.

iTunes 9.0.2 is an 85.82 MB download, and is 
available via Software Update or as a direct 
download. Remote is free and available from 
the iTunes Store, and is a 1.6 MB download.
Unless otherwise noted, this article is copyright © 2009 TidBITS 
Publishing, Inc. TidBITS is copyright © 2009 TidBITS Publishing 
Inc. Reuse governed by Creative Commons License.
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Hot Links of the Month
Compiled by Ron Heck

Apple, Inc.

Bill Gates praises Steve Jobs for 
saving Apple | AppleInsider
http://tinyurl.com/yakrx5d

Apple fourth best among build quality study for 
portables | Ars Technica
If you are an Apple user who pays a bit extra 
for improved build quality, a recent study 
shows that your assumptions may be incorrect.
http://tinyurl.com/yey6dlk

Steve Jobs: CEO of the Decade | Fortune
Why him? Steve Jobs revived Apple and 
remade entire industries, defying the worst 
economic conditions since the Great Depression 
— and his own serious health problems.
http://tinyurl.com/yev6sdn

Macintosh Hardware

27-inch Core i5 iMac (with Core i7 option) | 
Macworld
Top-of-the-line iMac takes the crown as fastest 
stock Mac model ever
http://tinyurl.com/yhkds8l

Benchmarked: The Quad-Core i7 iMac is Super 
Fast | Gizmodo
http://gizmodo.com/5407204/

21.5- and 27-inch iMacs (Late 2009) | 
Macworld
Apple’s all-in-one boasts new wide screens
http://tinyurl.com/y9sf72m

Core i7-Based 27” iMac Benchmarks Show 
Significant Improvements | MacRumors
http://tinyurl.com/ylzyck3

Why go Pro when iMac goes faster?
Core i5 and i7 iMacs bring Mac Pro speed to 
mainstream Macs
http://tinyurl.com/ylxm4gc

13-inch MacBook/2.26GHz (Late 2009) | 
Macworld
The MacBook gets the unibody treatment
http://tinyurl.com/yetxk93

Mac mini (Late 2009) | Macworld
Two Mac mini updates in seven months? 
Forgotten Mac, indeed
http://tinyurl.com/yksg5th

Walt Mossberg’s Annual Shopping Guide: Keep 
Buying Macs Kids | Cult of Mac
http://tinyurl.com/yfk3d88

Keyboards buying guide | Macworld
http://tinyurl.com/ya2sfum

Mice buying guide | Macworld
http://tinyurl.com/yzymmue

Mac OS X and Software

iPhoto ‘09: Troubleshooting and maintenance 
tips | MacFixIt
http://tinyurl.com/y8dzfqr

Students get discounts on Exchange-compatible 
Office for Mac | Ars Technica
In addition to the annual holiday discounts that 
Microsoft is offering on Office 2008 for Mac, US 
college students can now get the full Business 
Edition for 70 percent off the normal retail price.
http://tinyurl.com/y8gjut5
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Hot Links of the Month (continued)

Running Windows 7 under OS X: Ars reviews 
VMware Fusion 3 | Ars Technica
VMware has released the latest version of the 
popular Mac virtualization package, Fusion 3, 
and Ars puts it through its paces with a battery 
of benchmarks and usage scenarios. Read on 
and find out if this upgrade is for you.
http://tinyurl.com/yb2fwd2

Switchers Guide: Moving from Windows to the 
Mac
Expert advice on migrating from XP or Vista to 
Mac OS X
http://tinyurl.com/yenlvz8

Free “Take Control of VMware Fusion 3” 
Simplifies Windows on a Mac
http://db.tidbits.com/article/10692

iPod/iPhone/iTunes

iPod buying guide | Macworld
How to buy an iPod for yourself or your loved 
ones
http://tinyurl.com/yl7kk7w

The Complete Guide to Album Tagging, Art and 
Playlists in iTunes | iLounge
http://tinyurl.com/ygygfxr

The Complete Guide to iTunes Audiobooks, 
Podcasts + iTunes U | iLounge
http://tinyurl.com/ychslgl

Photo geotagging apps for iPhone | Macworld
Apps make short work of geotagging photos 
with your mobile device
http://tinyurl.com/yhaplao

Miscellaneous

Analyst claims Apple tablet will come in variety 
of different models | Edible Apple
http://tinyurl.com/ygy4j5u

Analysts: Tablet Could Offer ‘Stunning’ 
Graphics | Cult of Mac
http://tinyurl.com/y8lsutn

Wired for the Apple Tablet | Gizmodo
http://tinyurl.com/yavnr97

Interview: The Man Who Named the iMac and 
Wrote Think Different | Cult of Mac
http://www.cultofmac.com/20172/20172
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Members Helping Members
Need Help? Have a question the manual doesn’t answer? Members Helping Members is a group of 
volunteers who have generously agreed to help. They are just a phone call or an email away. Please 
call only during the appropriate times, and only if you are a current mini’app’les member and own 
the software in question.

............Apple II / IIGS Software & Hardware 1, 2
...............................AppleWorks / ClarisWorks 3, 4

........................................................Classic Macs NV
.............................Cross-Platform File Transfer 2, 3

.....................................................FileMaker Pro NV
....................................................................iMacs NV

.................................................Intel-Based Macs NV
.......................................................................iPhoto 3

..................................................iTunes / iMovie NV
........................................................................iWork 4

........................................................Mac OS Classic 3
.............................................................Mac OS X NV

................................................Microsoft Excel 2, 5, 7
...................................................Microsoft Word 2, 7

.......................................................................MYOB 5
.............................................................Networks NV

...............................................................New Users 1

...........................................................PhotoShop NV
............................................................QuarkXPress 7

....................................................................Quicken 5
........................QuickBooks and QuickBooks Pro 5

.............................................................VectorWorks 6

1. Les Anderson 651-735-3953 anderslc@usfamily.net DEW
2. Tom Ostertag 651-488-9979 tostertag@usfamily.net EW
3. Bruce Thompson 763-546-1088 bthompson@Macconnect.com EW
4. Pam Lienke 651-457-6026 plienke@aol.com DEW
5. Ardie Predweshny 612-978-9774  DEW
6. Charles Radloff 952-941-1667  D
7. Ron Heck 651-774-9151 ronheck@comcast.net DEW

D = Days, generally 9 am to 5 pm
E = Evenings, generally 5 pm to 9 pm
W= Weekends, generally 1 pm to 9 pm
NV = No Volunteer

Please call at reasonable hours and ask if it is a convenient time for helping you. By the way, many of 
these volunteers can also be contacted on our forums. We appreciate your cooperation.

mini’app’les needs more volunteers for Members Helping Members — If you are willing to be a 
Members Helping Members volunteer, please send an email message to Membership Director Les 
Anderson or contact him on our forums with your name, telephone number, contact hours, and the 
software and hardware areas you are willing to support.
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mini’app’les Membership Application and Renewal Form
Membership cost is $15.00 for one year. Please make your check payable to “mini’app’les”.

Name:     

Company (if mailed to):     

Address:    

City, State, Zip:     

Phone # (home):     

Phone # (work):     

Phone # (cell):     

Membership ID # (if renewal):     

Email:     
Your email address will NOT be sold, shared, or distributed. It will be used only for official mini’app’les business such as distribution 
of the newsletter and membership renewal reminders.

   Check if this is a change of address notice

   Check if you want to volunteer

   Check if you want to be added to “Members Helping Members”

   Check if you were referred by a club member (if so, please give member’s name)

Please mail this application and your payment to:
mini’app’les
P.O. Box 796
Hopkins, MN 55343-0796

Thank you for your support!

Benefits of mini’app’les Membership

• Access to the mini’app’les online forums. Post questions and/or answers about issues, trouble shooting, 
products, buying and selling, special events, discounts, and news about Apple and the mini’app’les club.

• Access to our Members Helping Members network of professional and advanced users of Apple technologies. 
These members volunteer their time to help other members with software, hardware, and other Apple related 
issues.

• A variety of Mac Special Interest Groups (SIGs) that meet each month.

• Multi-SIG meetings and workshops to help members with computer problems. You can bring your equipment 
to these events and receive support from knowledgeable Mac users to help diagnose your problem(s).

• Participation in drawings for computer hardware, software, and other computer related materials.

• Discounts from vendors and manufacturers. Refer to the on-line forums for current offers.
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mini’app’les
the minnesota apple computer users group, inc.

Introduction — This is the newsletter of mini’app’les, the 
Minnesota Apple Computer Users’ Group Inc., a Minnesota 
non-profit club. The whole newsletter is copyrighted © by 
mini’app’les. Articles may be reproduced in other non-profit 
User Groups’ publications except where specifically copyrighted 
by the author (permission to reproduce these articles must be 
given by the author). Please include the source when reprinting.

The mini’app’les Newsletter is an independent publication not 
affiliated, sponsored, or sanctioned by Apple, Inc. or any other 
computer manufacturer. The opinions, statements, positions, and 
views are those of the author(s) or newsletter staff and are not 
intended to represent the opinions, statements, positions, or 
views of Apple, Inc., or any other computer manufacturer. 
Instead of placing a trademark symbol at every occurrence of a 
trade-marked name, we state we are using the names only in an 
editorial manner, to the benefit of the trademark owner, with no 
intention of infringement of the trademark.

Questions — Members with technical questions should refer 
to the Members Helping Members section or bring their 
questions to an appropriate SIG meeting. Please direct other 
questions to an appropriate board member. 

Dealers — mini’app’les does not endorse specific dealers. The 
club promotes distribution of information that may help 
members identify best buys and service. The club itself does not 
participate in bulk purchases of media, software, hardware, and 
publications. Members may organize such activities on behalf of 
other members.

Submissions — We welcome contributions from our 
members. Perhaps you’re using new software that you just can’t 
live without. Maybe you have a new piece of hardware that you 
find extremely useful and of high quality. On the other hand, 
you might be struggling with problematic software or hardware.
Why not share your experience with other members by writing a 
product review? Doing so may steer others towards quality 
products or help them avoid the problems you may be having.

Submissions must be received by the 15th day of each month to 
be included in the next month’s newsletter. Please send 
contributions directly to our post office box (mini’app’les, PO 
Box 796, Hopkins MN 55343), email them to 
miniapples@mac.com, or email them to the newsletter editor at 
ronheck@comcast.net

The deadline for material for the next newsletter is the fifteenth 
of the month. An article will be printed when space permits and, 
if in the opinion of the Newsletter Editor or Publications 
Director, it constitutes material suitable for publication.

This newsletter was produced using Apple’s Pages word 
processor.

Board of Directors
President Bruce Thompson
 763-546-1088
 bthompson@macconnect.com

Vice President Tim Drenk
 952-431-3978
  tim@drenkconsulting.com

Secretary Harry Lienke
 651-457-6026
 plienke@aol.com

Treasurer Dave Lundin
 715-483-3776
 cdlundin@centurytel.net

Membership Director Les Anderson
 651-735-3953
 anderslc@usfamily.net

Publications Director Ron Heck
 651-774-9151
 ronheck@comcast.net

SIG Director Kevin Strysik
 65l-489-4691
 strysik@mac.com

Director at Large Tom Gates
 612-789-1713
 tgates@isd.net

Membership  Sandy Foderick
Coordinator sfoderick@mac.com
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